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Welcome to the PDQuest™ 2-D Analysis Software
Version 7.0/ 7.0.1 Update Training Guide

Bio-Rad is pleased to be able to distribute thistraining update as part of our
continuing Product Support and Training Effort for our Imaging Products.

This packageis designed to give you a compr ehensive tour of the newest releases of
our PDQuest software program, versions 7.0 and 7.0.1.

The PDQuest application has been extensively revamped with a multitude of new and
enhanced features, offering unprecedented automation of the front end of image
analysis and enhanced ease-of-use. PDQuest 7 also offer s enhanced integration of
mass spectrometer results, including a batch mode for importing protein
identification resultsthat will ssmplify the annotation and review of identified
proteins, and the ability to import identification results from Matrix Sciences
MASCOT software. Proteomic resear ch labs, in particular, will benefit from the
increased throughput in image analysis obtainable with these improvements.

PDQuest 7.0 (PC and Mac) and 7.0.1 (PC only) are available as part of The
Discovery Series™ software, Release 13 CD-ROM. A newly revised PDQuest
manual isalso part of thisrelease.

For userswhose license password includes version 7.0, or to obtain a copy for evaluation;

*The updated softwar e application can be obtained by ordering
therelease 13 CD aspart number 170-8605.

*The updated manual can be ordered as part number 170-8623.
*The application is also available for download at
www.bio-rad.com/softwaredownloads

An upgrade pathway is available for userswhose license password does not include version 7.0;

e Upgradestothe current release of PDQuest can be obtained by ordering catalogue number
170-8626. Contact your local Bio-Rad salesrepresentative for pricing information.

For more information, or to place an order, contact us at 1-800-4BIORAD in the United States.
Customers outside of the U.S. may call 510-724-7000 or contact alocal Bio-Rad sales office.
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PDQuest 7.0/ 7.0.1 TRAINING UPDATE
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PDQuest™ 2-D Analysis Software
Version 7.0/ 7.0.1 Training Update

With the release of version 7.0/ 7.0.1, PDQuest software functionality and tools have
been extensively enhanced. A developmental focus on process automation and
integration of datafrom avariety of sources will appeal to the proteome-oriented
researcher.

Highlights of PDQuest 7.0/ 7.0.1 include:
Significant New Featuresfor high-throughput oriented Proteomic labs;

* A new proprietary auto-matching algorithm eliminates the need to manually select
landmarks for matching

*  The auto-matching agorithm also eliminates the need to manually confirm Spot
Cutter excision targeting

* A new user—interface automates the front-end of image processing by combining the
Auto-match algorithm with the Spot Detection and Matchset creation steps

* Integration with WorksBase™ software for proteomics, a bioinformatics database,
for storage of image, spot, matching and annotation data

Significant Usability Enhancements;

*  Original 2-D Scan images are now available in Matchsets

* A proprietary SYPRO Ruby speckle filter has been added

* A Matching Summary table has been added which gives feedback on spot detection
and matching statistics

* Image Stack Tool has been enhanced to alow easier review of spot detection and/or
differential expression and new functionality has been added allowing usersto flag
visually identified spots of interest

* A new batch mode has been added for importing mass spec protein identifications
from Micromass, Matrix Sciences MASCOT, or WorksBase software

*  Exported TIFF image files can now include display of analysis overlays and
annotations as they appear on-screen in color
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PDQuest™ 2-D Analysis Software

Introducing SPoT ™ Technology: Addressing the 2-D Image Analysis
Bottleneck in the Proteomic Wor kflow

Market feedback consistently indicates the process of analyzing 2-D gels with software
packages to be one of the key bottlenecks in the proteomic research workflow.
Operations that have been regarded as most contributing to this bottleneck have been
identified as:

e Spot Detection

e Gel Matching

e Editing of Spot Detection and Matching

These operations can be broadly classified as steps that are required before one can begin
to analyze the gels for differential expression within the experiment. The shortcomingsin
the technology available to date can be thought of as two-fold; a) a need for automation
to reduce the time and user-intervention required for the spot detection and gel matching
steps and b) a need for greater accuracy in these steps which would reduce the
requirement to edit the results. Ironically, the operational step of performing the
statistical analysis of protein regulation has not been brought up as a similar bottleneck.
In al probability, thisis more areflection of the depth of concern focused on the spot
detection and matching stages than an acceptance that the analysis stage is being
performed efficiently. It is anticipated that should the bottlenecks perceived in spot
detection and matching be removed through automation and increased accuracy, attention
will shift to streamlining the analysis stages.

Bio-Rad has responded to this need with anew SPoT technology (Streamlined
ProteOmic Tools) developmental effort. Thisis acomprehensive and ongoing R+D
approach towards increased automation and efficiency in the proteomic workflow. Initial
SPoT technology development has been focused on the initial stages of gel processing to
address the critical bottlenecks. Asaresult, PDQuest 7.0/ 7.0.1 incorporates a new
proprietary auto-matching algorithm which eliminates the need for manual intervention
and significantly reduces the amount of time required to match gels within experiments.
ProteomeWorks Spot Cutter users will also benefit from this algorithm as it allows auto-
alignment of targeted spots during the excision process, eliminating the need to manually
confirm the excision targeting of selected spots.

Ongoing development of SPoT technology will address continued automation of the
image analysis process, improvements in accuracy, and further integration with Bio-
Rad' s ProteomeWorks System, as well as other data sources.
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Summary of major changes incorporated into PDQuest
versions 7.0/7.0.1

Significant New Featuresfor high-throughput oriented Proteomic labs;
* Proprietary Auto-matching Algorithm
— Automates Gel Matching
— Auto-aligns Spot Cutter excision targeting (faster performance & more options with version 7.0.1)
* Automation of front-end of image processing: Auto-detect and Auto-Match
— New user-interface offers One-step Spot Detection, Matchset Creation & Gel Matching
* Integration with WorksBase™ bioinformatics database (version 7.0.1)
— archive sample, gel, image, spots, matchset, etc.
— retrieve spot annotations (& MS identification)

Significant Usability Enhancements;
The “ Standard Reference” image is now referred to as a“Master” image
2-D Scan images are now available in Matchsets
A proprietary SY PRO Ruby speckle filter has been added
A Matching Summary table has been added (version.7.0.1)
Image Stack Tool has been enhanced
— alows user to flag spots of interest and create analysis sets for later review
— automatically adds flagged spots to Master Image (if not already present)
Spot Review Tool now alows common editing commands while open
— Tool now alows commands to add & delete spot, manually match & un-match spots, add spots to
Master
Allows batch import of M S protein identification info
—  Thebatch import mode is compatible directly with Micromass instrumentation or Matrix Sciences
MASCOT software results (version 7.0.1 required for MASCOT )
— indirectly (through WorksBase bioinformatics software) with Micromass instrument results as
well as MASCOT (Matrix Sciences) analyzed M S spectra from other mass spec instruments
Import of Text Files as Annotations (version 7.0.1)
File System and Archiving Changes
— Standard browser open/save dialogues are now supported (the previous PDQuest custom open
dialogueis still available as a user-definabl e option)
— Member images can now be members of multiple Matchsets and annotations can be shared
between matchsets or be private to a single matchset
— Matchset members can be found automatically if moved on the hard disk outside of PDQuest
Reporting
— TIFF images can be exported with color display overlays & annotations as they appear on-screen
— New report features have been added for selected reports, including Page Setup and Print Preview

Retired Features,
*Windows 95 is no longer supported
*multiple exposures of same gel are no longer supported
*Matchset file naming conventions
- PDQuest Matchsets now consist of a <name>.msfile and a corresponding <name> Data directory

— Previously a MatchSet was a directory
—  Previously could not be opened with the standard system open dialog

*PDQuest 7 will no longer open gelspot files produced by version 3.85 or older (1988)
—These files must be first opened and saved with PDQuest 6.2

See subsequent pages of thistraining update for additional detail on the above features
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PDQuest™ 2-D Analysis Software
Version 7.0/ 7.0.1 Product Update; Training Detail

New Features

Proprietary Auto-matching Algorithm

Historically, PDQuest software has relied on user-defined “Landmarks’” which serve asa
beginning point for internal matching algorithms to match and align spots across gels.
Whileit is asubjective, empirical process, how these Landmarks are chosen has alarge
impact on the speed and accuracy with which the matching stage is completed.
Consequently, there has been a demand for a*hands-free” approach to matching that
would fully automate the process and eliminate the need for user-defined Landmarks.

To address this bottleneck, a new proprietary auto-matching algorithm has been
developed and incorporated into PDQuest. As this algorithm does not require user-
defined landmarks for matching, the algorithm runsin afully automated fashion and
manual intervention is eliminated. In addition to automating the gel matching step,
PDQuest utilizes this new auto-matching algorithm in the ProteomeWorks Spot Cutter
interface to align the spots targeted for excision (in the analysis gels) with the fresh
image of the gel (in place on the Spot Cutter cutting platform). This auto-alignment
eliminates the need to manually confirm the cutter tip placement on the desired spots.

I mplementation of Auto-matching Algorithm in Gel Matching

Auto-match 1.
Fil: Edt View Image Spots | Match Analysis Identification Reports  Window Help
e 1 = Mew MatchSet on Disk. ..
B'ﬁé d:IQJ{'T?EI lew MatchSet on Dis ﬁ N

New Match3et in WorksBase, .,

MatchSet Toal..,
(Il Matchset PR1
.

Automated Matching. ..

Landrnark.
- Unlandmark

i
* - ) Classic Match Gel
e Classic Match Al Gels
) -

Edit Matches v (¥
Shaw Symbols F7
Show OFfsets Shift+F7

t Mark Landmarks Fi
Show Match Fa

" - Combine Overlapping Gels (Cyberzel)...

FRI (Masten) N =]
— Auto-Add Spots ko Master. ..

. o Add Spot to Master
- . Mark Added Spats Alk+FS
1 - Femove Added Spot .
- . -
v el & -

Launching New Auto-match algorithrh -

*Choose “Automated Matching...” from the “Match” file menu
*Note that the prior PDQuest matching method is still available as * Classic Match”
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Auto-match 2.

(11} Automated Matching... Matchset PR1 il

¥ hal Primary Matching | Extended hatching

Find landmarks autormatically and calculate an accurate matching

[JEnable overdapped pH-range matching

Matching liberal strict

Precision T J' 50

@Match symbol color is green

Matching settings |Defau1t Match Settings ﬂ
Members |ha1f1 vl (Gaussian) ~|
d Matches: |M/4 Extensions: |NJA Sum: |NIA

sto

-_ MatchAII| katch | ¢ Done |‘X_ Cancel|@ Help |

Auto-match; Primary Matching dialogue

*Auto-match dialogue consists of two tabbed menus

*Auto-matching can occur as a one-stage or two-stage operation.

*The Primary Matching tab menu controls the initial stage matching parameters
*Matching parameters are set with an intuitive slider between liberal (more distortion
allowed) and strict (less distortion allowed). The range of the slider isfrom O to 100
allowing settings to be duplicated and adjusted in fine steps. The value “50” in the screen
shot above indicates a balanced setting between liberal and strict values.

*Specific members can be matched individually against the Master image by selecting the
member and selecting the “Match” button, or the same settings can be applied to all gels
in the Matchset by selecting the “Match All” button

*The results of the Primary Matching stage are indicated with green letter match symbols
*The “Enable overlapped pH—range matching” checkbox option is useful when
comparing gels run with overlapping, but not identical, pH range first dimension IEF
separations. Enabling this option allows the matching algorithm to look for vertical,
overlapping regions where matching can be expected between the gels, and attempt to
match only in this region. The matching algorithm will ignore the regions to the left or
the right of the overlap region. Enabling this option before matching is a pre-requisite to
later merging the gels to create a synthetic image (or “CyberGel”) view. In a CyberGel,
the Master Image is shown with an expanded pH range extending across the extremes of
the overlapping | EF regions used to construct it. The “Combine Overlapping Gels
(CyberGel)” command from the Match menu is used to generate this synthetic image
view (see figure Auto-match 1).




Auto-match 3.

e
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(L Automated Mastching.. Matchset PRI e

Primary Maiching | Extandad Matching

CEnable overdapped pH-mnge maiching
R | ;i

Msiching libieral

Fracisian A

(&) Match symbol color is green ————

Malching seftings [Default Match Settings =
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- GhMench Al Mexh | Done | % Cencel | @ Help |

Recalling pre-saved Matching Parameters
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*Default Match Settings specify use of Primary Matching only, using a balanced strict-

liberal setting of “50”

*Other Match Settings can be recalled from a user saved list of optimized parameters
*Changing any current setting values will prompt the user to name and save the new

parameters

Auto-match 4.

.
- | L |

[LJ' Automated Matching... Matchset PR1

[Ld PDQUEST

Select Method

@Match symbol color is blue

¥ hat Frimary Matching | Extended Matching| Disabled
e
. Choose the method which will be used to extend th o1 -
assic
Extension method |Disabled E
L - liberal
Matching
Stringency [ | 50

Matching settings |Default Match Settings

Members |half1 vl (Gaussian)

KNER

d Matches: [M/L Extensions: |Nh1

Sum: |Nh1

EhMatch Al Match |

 Done |)(_ Cancel | (@ Help |

Auto-match; Extended Matching dialogue

*The Extended Matching tab menu controls a second stage of matching parameters which
allow extension of the matching results achieved during primary matching
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*Three Extended Matching methods are available:

1- Disabled; no secondary matching is performed
2- Restricted; the new auto-match algorithm is applied during secondary matching
3- Classic;  theoriginal PDQuest matching method is applied during secondary
matching. Results of Primary Matching are used as Landmarksif this
option is chosen.
*Restricted Matching parameters during Extended Matching are set independently from
the Primary Matching parameters with an intuitive slider (with the same flexibility as
Primary Matching)
*The results of the Primary Matching stage are indicated with blue letter match symbols

Auto-match 5.

[L) Matchset PR1 {(Modified)

Match symbois (matched: 146w Llatch symbols (matched: 100w Match symbols (matched®6 unf Match symbols (matched: 73 unf

FR1 (Master) I halfl w1 (Gaussian)k half2 1 (GEussianl( half3 vl (Zaussia
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k2 od' W W 7 4w Wq oy tw Wy |
i o, ® . g. . . - - z Sq = 2
qw u o u k g

- r - -
Match symbols (matchedi 154w Match symbols (matched:136 w Match symbols (matched: 145
stockl il (aussiak) stockd vl (Gaussiam) stock3 gl (Gaussian),

Results of Primary and Extended Matching

*Primary Match results are indicated in green.
*Extended Match results are indicated in blue. Note the additional match found in gel
replicate “stock?2” above by Extended Matching.
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I mplementation of Auto-matching Algorithm in Spot Cutter Targeting
(Asappliesto PDQuest version 7.0 ONLY)

PDQuest 7.0 and 7.0.1 have different implementations of the Spot Cutter auto-alignment
interface. It isrecommended that all Spot Cutter users run version 7.0.1 to take advantage
of faster auto-alignment performance. If you are running version 7.0.1, please turn to
page 14 for adescription of the interface.

7.0 Auto-align 1.

(0 wiion analycis and Cutter

AR ]

!Muiﬂm’ @ Light an iGel} CIDesplery o merks
" Light o (PVDF) FDisplay matchos
Uvan Far) Tmotsecst [ EDspley o eree
HAuno-To0m mage
’r‘ For Manual Correction, drag any cut mark on camers image anytime. Compute cul s |
HDispley o overdaps
3 Begnifievime | CiPoston detabos| 3 Comcel |0 Helo |

Implementation of Auto-match algorithm in Spot Cutter

*Use“Acquire Image “ button to take image of gel on Spot Cutter platen:

7.0 Auto-align 2.

Le Abgn Analysts and Cutter Images

N 2]x)

Lookin: | Sampla Matchsats > @

beta 355 excwkn Daka [ Doma PRLns
1 _beralaz Data ] demmo P e
3 £ Germnbech beta 42 ms
r ]

] HUML 0bens
a PR |
E5) et s
best 121201 ms

Fila name: [Copy 3 ot stockigue

Open
el |

Files of type: |Loadable Images and Malchsets

g

3
o
]
4

Opening gel filein Spot Cutter simulation mode

10
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In demo or tutorial mode (i.e., without a Spot Cutter attached), the software has an option
to run in Spot Cutter simulation mode
* Note use of Standard Windows browser above to find gel file to load into Spot Cutter

Tip! If running in Spot Cutter Simulation mode, PDQuest software
will not allow a file with the same file name as the analysis image to
be opened into the Align Analysis and Cutter Image window. In
order to simulate the spot cutting process, it is necessary to have
prepared a copy of the target gel raw scan file in advance under a
different name (for example, “ Copy of stock3.gsc”)

7.0 Auto-align 3.

1 -
® Fit gaussians to spots (pass 8)
| |

Automatic initiation of auto-alignment

* Onceimageisacquired (or fileisloaded if in Spot Cutter Simulation mode) the user
is prompted to confirm the location of the data area box.

» Confirming the data box arealocation then automatically initiates Spot Detection on
the Spot Cutter image and Automatic Alignment of spotsin the Analysis and Spot
Cutter images.

7.0 Auto-align 4.

(11} PDQUEST

& Canfirm the auto-alignment and MAMUALLY correct it (if needed).

1. Using the Slider, set the minimum acceptable confidence.
2. Znom on a spot in analysis image if greater visibility is desired.
3. Press Jump and Confirm button repeatedly to wisit spots having unacceptable confidence.

MANMUAL Correction: You may drag any cut mark anytime on the cutter camera image
to manually correct its auto-alignrent.

4 OK

Utilize matching confidence thresholds to target matched spots for review

* Optional step; user can proceed directly to spot cutting if desired
» User-defined confidence thresholds indicate which spots to review (if any)

11
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7.0 Auto-align 5.

=% e
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LT L, s A * % = o~
3 --1 = = o r -.1 = *
L. - 3 EY LA -
. : j @l e - j
’ - - o ’ - A
. -~ . ] . -
[z

Cenfidence at Spat [0 Jump and Confirm

Confidence Threshold

MNurnber of cuts below confidence (13
Mumber of cuts abowe confidence |0

@For Manual Correction, drag any cut mark on camera image anytime

f|2oo

[l Acquire image | & Light an (Gel)

 Light off (PYDF)

£ U on (Fluor) Time(secs)

[IDisplay cut marks
[XIDisplay maiches
[l Display cut area

HAuto-zoom image

Compute cut overlaps

[ Display cut overlaps

Alignment Review Tool: All spots require review if confidence threshold set at 100%

» Note feedback on number of targeted cuts at or below threshold (red) and above the
user-defined matching confidence threshold (green)

7.0 Auto-align 6.

Confidence at Spat [0 Jurp and Confirm

Confidence Thresholid r
MNumber of cuts below confidence |0
Mumber of cuts above confidence 13

@For Maral Correction, drag any cut marks on camera image anytime

S -

- = e
. SRS braaac | T heaaac 2
Pt LT o = FritE e S
b - '--_ - ] ;“,4 - s Y - - :"-:‘ . o
- > e - e T = _'! S - r LT S -
ST e e T - - e S Jrat
* - = - ol .- .4 = T
. . - 3 Y . - -
L . ) = -t ’
i - . | ) - A
L ~ o L -~
|

fla Acquire image | & Light an (Gel)

L
<LK

[IDisplay cut marks

ght off (PVDF) [¥Display matches

" on (Fluor) Timetsecs)

[¥Display cutarea

B Auto-zoom image

Compute cut overlaps

[ Display cut overlaps

Alignment Review Tool: Some or all spots may require review when confidence

threshold is set lower than 100%

» Only spots at or below the matching confidence threshold will be reviewed
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7.0 Auto-align 7.
a4 4
- 9 -

EBE kD

Confidence at Spot | 100 Jump and Confirm s Acquire image | & Light on (Gel)
Confidence Threshold r J ioo " Light off (FvDF)
Murnber of cuts below confidence |13 =10 on (Fluor) Time(secs)

Mumber of cuts above canfidence (0

@For Mianual Correction, drag any cut mark on camera image anytime.

Review of Spots with Confidence Scores that are at or below the Defined Threshold

» Adjust the zoom setting as desired and click the “ Jump and Confirm” button to

sequentially review spots that are at or below the user-defined confidence threshold
 If desired, Spot Cutter targeting can be adjusted manually on the Spot Cutter image
» At any time, user can initiate spot cutting

13
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Implementation of Auto-matching Algorithm in Spot Cutter Targeting
(Asappliesto PDQuest version 7.0.1 ONLY)

PDQuest 7.0 and 7.0.1 have different implementations of the Spot Cutter auto-alignment
interface. It is recommended that all Spot Cutter users run version 7.0.1 to take advantage
of faster auto-alignment performance. If you are running version 7.0, please turn to page
10 for adescription of the interface.

The Spot Cutter control interface has been extensively revised in version 7.0.1.
e Theahility to reorient the gel image has been added, eliminating the requirement
to physically reorient the gel on the cutting platen surface
o The Gel and Excision Target auto-alignment operation is significantly faster
The ability to display multiple cut excision targeting is now available
e The ability to display approximate protein contribution from nearby overlapping
spotsis now available

[L Align Analysis and Cutter Images

E-A= Iﬁ@lﬁ

Stepl : Image Acquisition Step 2: Data Box Placement Step 4: Alignment Confirmation Display Options
fhAcquire image S Reposition Display Mode ¢ Qriginal Enfire mage ¢~ Cropped Image ECutmarks {iCutares

& Light on (Gel] ﬂJJg  Jump and Confirm | Confidence at Spat 0 ihatches  DiMultiple cuts
r~Lightaff (VD) Confidence Threshold 100 ¥ Autozoom 3 Data Box
S UEE ) T ’7 Step 3: Perform Alignment MNumber of cuts below confidence outof atotal of 0 Compute cutoverlaps

23 A o @For Ivfanual Correction, drag any cut mark on camera image anytime i Cut overlaps

iF AUl ‘ ~;-¢Manual‘

#2Begin/Resume Cuttingl 5K Cancel ‘ 1] Help |

Revised Four-step interface for Implementation of Auto-match algorithm in Spot Cutter

14
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7.0.1 Auto-align 2.

—stepl @ Image Acguisiion———— Step 2: Data Box Placement
fliAcquire image :
& Light on (Gel)
™ Light off (FYDF)
1% on (Fluor) Time(secs) Step 3: Perorm Alignment
{ i Auto ?{:%EManual| —‘

Revised Alignment Workflow- Steps 1 through 3 allow image acquisition, reorientation
of gel, and initiation of alignment

*Step 1- Use “Acquire Image “ button to take image of gel on Spot Cutter platen
*Note: Until an image has been acquired, the commandsin Step 2 and 3 are “asleep”
and unavailable

7.0.1 Auto-align 3.

(Ll Al Analysis and Cutter Images

Open

Lookin: [ Sampla Matchsats

File name: [Copy 30t stockd gue

Files of ype: |Loadable Images and Malchsets

Opening gel filein Spot Cutter simulation mode

In demo or tutorial mode (i.e., without a Spot Cutter attached), the software has an option
to run in Spot Cutter simulation mode

* Note use of Standard Windows browser to find gel file to load into Spot Cutter

Tip! If running in Spot Cutter Simulation mode, PDQuest software
will not allow a file with the same file name as the analysis image to
be opened into the Align Analysis and Cutter Image window. In
order to simulate the spot cutting process, it is necessary to have
prepared a copy of the target gel raw scan file in advance under a
different name (for example, “ Copy of stock3.gsc”)

15
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& LA x

T- & Step 2 Position the green data area box.

1. Ifincorrect orientation, flip and/or rotate. »
2. Drag and drop the data area box in the camera image (fight-hand pane) o that

it encloses exactly the same area as the analysis image (left-hand pane).

3. Proceed to Step 3

o 0K

Step1 : Image Acquisition Step 2: Data Box Placement— -Step 4 Alignment Confirmatio
fhAcquire image EReposition Display Mode " Original Entire Image ¢~ Cropped Image
I A &
& Lighton (Gl e . Jump and Confirm | Confidence at Spat 0

Post-acquisition user prompt

After animageisacquired (or afileisloaded if in Spot Cutter Simulation mode), the user
is prompted to confirm or correct the position of the data box and to re-orient the gel
image if necessary

* Click “OK” in the user prompt dialogue to proceed to Step 2

7.0.1 Auto-align 5.

~Stepl @ Image Acquisition————  Step 2: Data Box Flacement—
faAcquire image ElReposition
S T
& Light on (Gel) 3| ) £ D]

¢ Light off (PYDF)

I on (Fluon Time(secs) Step 3 Perform Alignment—‘

i Auto | +Manua||

Step 2 and 3 commands “wake up” once an image is loaded.

If necessary, data box should be repositioned to match placement on the analysisimage.
Gel image re-orientation options include;

flip horizontal

flip vertical

rotate 90 degrees left

Rotate 180 degrees

Proceed to Step 3 and choose “ Auto” to initiate auto-alignment using the new automated
matching algorithm (or choose “Manual” to use the manual target confirmation method).

7.0.1 Auto-align 6.

16
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- D - ol & i1
2 . g & -
: | -
i . s

POOUEST

& @ Fit gaussians to spots (pass 8).
|

Initiation of auto-alignment of gels and Excision targets after choosing “Auto” in step 3

7.0.1 Auto-align 7.

(11l PDQUEST x|

& Confirm the auto-alignment and MANUALLY correct it {if needecd).

1. Using the Slider, set the minimum acceptable confidence.
2. Zoom on a spot in analysis image if greater visibility is desired.
3. Press Jump and Canfirm button repeatedly to visit spots having unacceptable confidence

MANUAL Correction: You may drag any cut mark anytime on the cutter camera image
to manually correct its auto-alignment

4 OK

User pror’ﬁgt«to_fi'ltér by matching confidence in Step 4 for optional review of spot
targeting

» Step 4 (reviewing spot targeting) is an optional step; user can proceed directly to spot
cutting if desired

7.0.1 Auto-align 8.
|

Stepl : Image Acquisition Step &: Data Box Placement—| -Step 4: Alignment Confirmation Display Options
fhAcquire image El Repasition Display Mode ™ Original Entire Image & Cropped Image [XICut rmarks  []Cut area
@ Lighton (Gel) ﬂJﬁﬁ @, Jump and Confirm | Confidence at Spot W EiMatches  COMultiple cuts
o~ Light aff (FYDF) Confidence Threshold r J W [®]Auto-zoom  [x]Data Box
UV on (Fluor) Time(sees) ’— S B Ptz e Murmber of cuts below canfidence r outof a total of ,1117 Caae s o
G Ao ‘ »’;-Manual‘ —‘ @For MManual Correction, drag any cut mark on carnera image anytime [CICut overlaps

Use confidence threshold dlider to review low quality matches for review

Step 4 allows users to utilize matching confidence thresholds as afilter to select excision
target spots for review and confirmation (or correction) of spot targeting accuracy.

» User-defined confidence thresholds indicate which spots to review (if any)

» Toreview and confirm spot targeting, the user should first use the zoom box to
format the display to a convenient close-up view. Then, use the “ Jump and Confirm”
button to successively load each spot excision target that falls below the defined
confidence level into the view area.

7.0.1 Auto-align 9.
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Lowering confldence threshold reduces the number of spot requiring confirmation.

e Spots above the confidence threshold are indicated in green on the image.

7 O 1 Auto-allgn 10.

all -
-| &l
ol ot
i - P [ S8 . 3
i+ 1 H .y
-. . Ll .' .
b A et
e e
Step] : Image Acquisiton - Ditplay
!Aq i g “hena-m fali? = {s[=TETR
@ Lighton (Gel i = &) Ehwandcwﬁml Confidence ot Spot [0 [EMetches  CMubiple cuts
£ Light ol (VD) | Thresseld | Jioa (EAuto-rocen (& Datn Bex
U oo (Flusd) Timefeace) [T | rStn 3 Podorm Aligeeont - e ny LU Lo e ol |5 Campatis cut everleps |
[ G hans | tanunl [For Mimual Comrection, rag ary il rak on ciners erige aylime Qv cveriops
D BoginFosume Cuting| % Cancel |@ Holp |

Increasing confidence threshold increases the number of spot requiring confirmation.

e Spots below the confidence threshold are indicated in red on the image.
e  Setting the confidence level threshold to 100% will allow all spot excision targets
to be viewed with the “Jump and Confirm” button.

7.0.1 Auto-align 11.
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Review of Spotswith Confidence Scoresthat are at or below the Defined Threshold

EBE 2R

» The currently selected spot isindicated in blue.

» |If desired, Spot Cutter targeting can be adjusted manually on the Spot Cutter image
by dragging the targeting indicator to a new position.

» At any time, user can initiate spot cutting

-

7.0.1 Auto-align 12.

. s L i |45 -Display Options
. SR X Cut marks [JCutarea
X kdatches HMultiple cuts

X Auto-zoom [ Data Box

/ Compute cut overlaps

X[ Cut owerlaps

Display Options.

Display interface includes ability to;
e display multiple cut targeting (when multiple cut option has been selected from
Excision Gel Selection interface screen)
e compute and display cut overlap contribution from neighboring, overlapping
spots to the targeted excision area

7.0.1 Auto-align 13.

OB uw «

Close up of multiple cut targeting display indicator.

* Individual multiple cuts can also be selected and repositioned manually.

7.0.1 Auto-align 14.
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- 95%
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Close up of cut overlap contribution indicator.

In the above example, the current cut areafor the targeted (blue) spot will contain
approximately 5% of the neighboring spot.

e User must select “Compute Cut Overlaps’ before selecting the “ Cut Overlaps”
check box to display the results

e Thiscaculation is made from the original analysis gel. It is not recalculated as the
excision target area is repositioned manually

e Thecalculation is approximate and indicated in 5% increments (due to the
inaccuracy of attempting to cal cul ate the absolute amounts of two different
proteins with different affinities for the same protein stain)

Automation of 2-D image processing: Auto-detect and Auto-Match

One of the most frequent concerns raised about software analysis of 2-D gelsisthe
amount of manual intervention associated with preparing the scanned digital gel images
for statistical expression analysis. As sophisticated as 2-D analysis software has become
in recent years, a high degree of user intervention has typically been required to guide the
software through spot detection and gel matching. A new user-interface offers one-step
Spot Detection, Matchset Creation & Gel Matching. By automating these operations,
which compose the “front-end” of the 2-D image analysis process, PDQuest speeds the
user to the review and spot population statistical analysis stages of the 2-D gel analysis
process.

Automation 1.

File Edit ‘View Image|Spnts Match  Analysis  Identification Reports Window Help

; v Jetection and Matching {on Disk)... 5
Edit Spot Tools :
Spot Detection Wizard
woe o g @ P e B

Auto-Detection arianlaIching automates the “front-end” of 2-D image processing

» Single Auto-detect and Matching dialogue window is accessed from the “ Spot” menu
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Automation 2.
[L) Automated Detection and Matching on disk ll
~Step 1-Select Gels To Analyze rStep 3 - Create MatchSet
Add kiml a-4f MName [rultitime point analysid] Auta
I kim1a-11 Description |
EFRemove kirnla-2
Kirm1a-2f Comments
I Master Kirri1a-3
Direcio C\Program Files\Bio-Rad Beta\Sample Matchsets Change
kirnla-3f & | : £ ﬁ
kirn1 a-4 lember sharing
kil a-1 & Do not make copies; refer to the originals
™ Copy the originals inta this matchset's data folder
[IDisable this step
Count (8 @Drag items to reorder them
~Step 4 - Match Gels
Step 2 - Detect Spots onh Gels Parameters [2ndary match restricted j Edit...
Parameters |kim1a-3f j Edit... ‘ [IDisable this stap

Log File Name [sadown_20020414_2024

5 Go ‘ ‘XCanceI| @ Help |

Auto-Detection and Matching dialogue window

» Only four steps are required to establish parameters for spot detection, matchset
definition and matching

1- select gelsto include in matchset and pick a Master

2- recall parameters for spot detection from a previously optimized set or choose
“edit” to launch the Spot Detection Wizard in order to optimize parameters for
thisgel set

3- define the Matchset name and archival directory

4- recall parameters for matching from a previously optimized set or choose

“edit”
to launch the Automated Matching dialogue window in order to optimize
parameters for this gel set

» Use can elect to disable automation at either the matchset definition step or the
matching step

» Original images can be copied into the data directory (establishing a“private” copy of
the datawhich is specific only to this matchset) or the origina data can be referred to
on its current location on the disk (establishing a*“shared” copy)

A Matching Summary table has been added which gives feedback on spot detection
and matching statistics

(As appliesto PDQuest version 7.0.1 ONLY)

A summary view of the results of Spot Detection and Matching is presented which is
particularly useful during the optimization of matching parameters. Users can assess the
effects of different matching methods and sensitivity settings by comparing the resulting
changes in the number of Matched spots or in the Match Rate.
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Match Summary 1.
1 Jﬂ Matching Summar il
rMember infarmation
! |Ge| Name" Feplicate Group "Spots ||Matched ||Match Fate || Corr Coeff "Det
| hatft st [half | 420 | 385 | 91% ELE |stor =
halfz w1 | half | 395 | 385 | 92% [0514 [stae
half3 w1 | half | 391 | 33 | aB% | 0,930 [star
*stack] w1 | stack | 819 | 7a0 | 95% | 1.000 [star
stack2 w1 [stack | ang | 659 | &1% | 0.942 [stoc «
| | 1|
@The matchset master 1s marked with * Correlation coefficient based on [stockl w1
i rMatchset infarmation Feplicate groups informatian
Spots matched to every member: | 308 Feplicate Group | Members| tatched 1o all | hean Cv
Crerall mean coefficient of YT half 3 318 10.64
wariation of all replicate groups: . tock 3 504 1811
o Close | H Mormalize | Fematch | ScatterPIDt| [ Help

Matching Summary table window

The Matching Summary window is automatically presented following AutoDetection and
Matching, or can be recalled at any time from the Match menu. It presents statistics for
each gel image based on the results of Spot Detection and Matching offering insight into
the success of those operations.
* The available member gel information includes;

- Gel image membership in Replicate Groups (if assigned following AutoDetection)

- Number of spots detected for each gel

- Number of spots on each gel that matched to the Master image

- Match Rate for each gel (ratio of # spots matched to Master against the # spots on the

Member Gel)

- Correlation Coefficient for each gel (the averaged ratio of spot quantities on the
Member gel against the matching spot quantities on the Master Gel for each
matched spot on the member)

* The available Replicate Group information includes;
- # of spots that matched across all members of the Replicate Group
- Mean Coefficient of Variation (of spot quantities) for all spots that matched across all
members of the Replicate Group
*The available Matchset information includes;
- # of spots that matched to every gel
- Mean Coefficient of Variation for all the Replicate Groups
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Match Summary 2.
rMember infarmation
Detect parameter | Idatch settings "Lng file
stock3 Classic bsadown_20020610 ﬂ
stock3 Classic bsadown_20020610
stock3 Clagsic bsadown_20020610
stock3 Classic bsadown_20020610
stock3 Classic bsadown_20020610 LI
El B
Additional scrollable information fields in Matching Summary table
*Additional fields are available by scrolling the table window, including;
- Spot Detection Parameter file names
-Match Setting Parameter file names
Match Summary 3
lm Matching 5ummarf il

~tember infarmation

|Ge| Name"RepIicate Graug ||Spnts ||Matched ||Match Rate || Caorr Coeff ||Det
| hatfl w1 [half | 420 +0 | 386 + | 91% +0% |0.920 +0.002  [stoc =
half2 1 | half | 395 +0 | 362 3 [ 91% +0% [0915+0.005 [stoc
half3 «1 [ half 391 H 386 17 % 5% | 099001 m
*stockl w1 | stock 818 H0 790 H0 96% +0% | 1.000 +0.000 ’E
stock2 vl | stock 809 +0 703 +44 86% +5% |0.935-0.006 stoi - |
RiN 2
@The matchset master 15 marked with * Correlation coefficient based on |stock1 vl
rtdatchset information Feplicate groups information
Spots matched to every member: | 331 +23 |P{ep|icate Group "Members "Matched ta all ||Mean CW
Ovn_er&_ull mean caef_ficient of _ 14.95 1058 half 3 340 +22 11.21 4#0.58
wariation of all replicate groups: - 3 EA3 +49 186 {057
¢ Close | - Normalize | Fematch | Scat‘terPIDtl [ Help |

Use comparative results (based on “Rematch”) to optimize Match Parameters

» The “Rematch” option allows the user to select different match settings or methods and
compare them to the results achieved with the prior settings. The resulting Summary
Table for the new match settings will add a display of comparative results for key match
indicators relative to the prior settings. Shown above is an example where the number of
matched spots and the match rates seem to have been improved by selecting different
matching parameters. Comparative data (based on “Rematch”) is presented for the
Member gels, Replicate Groups, and the Matchset, including;

- Number of spots detected for each gel

- Number of spots on each gel that matched to the Master image

- Match Rate for each gel

- Correlation Coefficient for each gel
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- # spots that matched across all members of each Replicate Group

- Mean Coefficient of Variation (of spot quantities) for all spots that matched
across all members of the Replicate Group

- # spots that matched to every gel

- Mean Coefficient of Variation for all the Replicate Groups

I ntegration with WorksBase™ softwar e for proteomics, a bioinfor matics database
(Asappliesto PDQuest version 7.0.1 ONLY)

PDQuest 7.0.1 includes seamless integration to WorksBase software for Proteomics for
the storage of 2-D gel dataand retrieval of associated protein information.

Archive data:

All parameters of PDQuest analysis of 2-D gels can be saved in WorksBase, including
archiving of; samples, gel images, spots and spot data, matchsets, matching info, analysis
sets, annotations, cut lists, etc. PDQuest can also open images saved in WorksBase for
analysis.

Retrieve protein identifications:

PDQuest can retrieve M S identification information that was automatically written to
WorksBase and import it as a spot annotation for viewing within theimage. A cut list
must have been generated initially to drive the spot excision and identification processin
order to import these M S identifications.

Additionally, PDQuest has data input screens that parallel many of the sample
characteristics screens in WorksBase. This flexibility allows the user to conveniently
enter or view sample characteristics within the database while working within PDQuest.

WorksBase integration 1.
| (L Preferences i‘

Misc H Paths || Display HTnn\bars HApp\icalinn” Imagers

Memory Allowance |51z .00 I

Institute Name [Bio-Rad Laperatories

[¥]Enable WarksBase commands (%] Maximize application window

@ File-based commands are featured W Gt G Bl

 WorksBase comi o featured

Getname for [JMNetwork drives [JRemovable drives

[JEnal
JEnal

Otuttiple Mouse Assignment Mode

[Enable DOS filename parsing

REnahle Unixfilename parsing

0K | K Cancel| @ Help
WorksBase menu commands are enabled from the user preference menu

e User can configure either the local disk or WorksBase storage as the default
method

WorksBase integration 2.
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Saye o Disk
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Save in Place
Saye Allin Place.
Revert to Saved,.,

Close At

Close Al

Unload CErlH

Gel Doc...
Chemi Doc...
G3-700...
E5-710...
G5-800...
Fluor-5...
Fluor-5 MAX...
Fluor-5 MAK2...

Match  Analysis  Idenkification Repc

Save Allin WorksBase),,
RenamefRelink in WorksSase. ..

Custom Forms..,.
Query...
Report wizard...

Column description report...

Login...
About,.,
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Users can elect to open or save files on either the local hard disk or the WorksBase server

WorksBase integration 3.

Login

ﬂ
Furpo:
Usemame [SUPERUSER ¢~ Read-only
< Biead-write

Password |

¢ Administrator
<~ Status Only

o Dane | ¥ Cancel

WorksBase provides multi-level, secure log-in when accessed from PDQuest

WorksBase integration 4.

(L] open From WorksBase

= Project Narme

|Slan Date

|Program Marne(Prograrm)

Concentration Study
Hypertension Study

ﬂ @Prmads -

Unfiltered

ﬂ &w Experiments o

in project

ﬁ Eﬁ Samples o

in project
ﬂ %an Dim Gels
inproject
[T
ﬂ [ Matchsets

in project

time course

Page ﬂ‘\ ﬂ Records in page |3 selected |1 7 Filter...

Open Image(s)
[E50pen Matchset(s)

B Edit.

B Wiew.

> Cancel
1] Help

Images, matchsets, samples, etc. can be archived in the context of research programs or
projectsin WorksBase

Hierarchal menu relationships allow user to filter entries in context, for example, all the
samples or gels that belong to a particular research project.
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(L) custom Form

15t Dimen Gel

%]

2nd Dirmen Gel

Click

Author

Experiment Step
Experiment
Individual
Microtiter Plate Type
hicratiter Plate
Project
Research Program

Sample

[l Insert Sample

Gel Mame

e |

Gelldentifier & ‘20020415202732

Geltype
User name

rGel information

= |

pH Low
Dimensions

Batch numher

Voltage prog

K Hours

Limiting Current
Gel Running Time

Limiting Yoltage

Protein loading

Sample

Canditions:

Sample volume ‘

Units

‘Write dataset

User admin =

# Insert ‘CDpyerm...l"‘a Clear

¥ Cancel

x

Sample Name (= |

Sample ldentifier = |2DD2D4152D2519

—

Sample Acquisition Date

Sample Tvpe

Species

Cell

Tissue |
Organelle |

Sample Prep Author

Treatment

Sample Acquisition Conditions

Sarmple Description

Sample Purpose

Arnotation |

Sample Volume Units |

User admin j

M Insed |Cnpy1mm ‘"“E Clear

YWrite dataset

‘ W Cancel

PDQuest Custom Forms

PDQuest Custom Forms allow entry of nearly all aspects of sample characteristics or gel
conditions to be entered into WorksBase archives

e Hyperlinksto database entriesin WorksBase allow recall of stored attributes and
parameters, eliminating redundant data entry.

WorksBase integration 6.
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Selest Table(s) -Seledt Calumng 1
EEPT_STER_SOLUTION_EATCH 2| [ coomn_mrrs E
EXTERNAL_FEFERENCE SOURCE o GAT! QUANTITY
EXTERN_REF_RELATIONINIP GEL_RECORD . CROST_LINKER
FARILY 20RD , DETECTION_GUANTITE
FEATURE_TYPE_LUT R0 . D INENS IONS
L =i CORD. END_BATE

CEL_RECORD . CEL_DESCRIPTION

GEL_RECORD .GEL_IDENTIFIER

GEL_RECORD, GEL_NANE

GEL_RECORD .GEL_RUNNING TIME ﬂ
GEL_RECORD . GRADIENT_TYPE ﬂ
GEL_RECORD, K¥_HOURS

GEL_SET_NENBER LIEITING_CURFENT
GEL_SPOT 0. LIRITING_VOLTAGE
GEL_SPOT_ANNOTATION CEL_RECORD . MATCH _STATUS
GEIL_TYPE GEL_RECORD . MONCHER_CONCENTRATION
GENT_ANNOTATION GEL_RECORD, NOWONER_TTRE
GENE_AUTHOR GEL_RECORD .MR_HIGH
GENT_CITATION
GENE_EXPRESSION_NALYSIS = =]

Racord rapo| % Cancel | [ Heip |
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~Records To Repon

SROT_IDENTIFIER
GAUSSIAN_QUANTITY
RCREALIZED_CUANTITY
L0

134

SROT_QUALITY
SHAPE_FACTORS
ORIG_X_COORD

ORIG_Y_COSRD

PDQuest Custom Reports

PDQuest Custom Report Forms allow user to generate custom reports containing

information stored in WorksBase

WorksBase integration 7.

| T woet:
[ Seluct tabile Selet eied

ADDEESS il = Authar I Author Famnatted Nave |

AGGREGATE_GEL_SPOT 1 Ara Y i'
2 Adachi 'W.
3 Adcalsuka H.
] Mkiyama T

z 5 Mipn P 0

AHOTATION_CATEGORY &

AMNOTATION_CATEGORY_USE F

AEIOTATION_USE B
]
0

APPLICATION_SFECIFIC_DATA "

ARRAY_POSITION_RESULT 12

ARRAY_POSITION_TENPLATE 13

AUTHOR m

BATCH_IMGREPIENTS 5 Bargoumian |

BINART_ANNOTATION 16 Embaum O

cELL " Burstowiki S

CELL_CRSANELLE 8 Chen B.K

CELL_BELATIONSHIF =l 12 ChenL
o Coulier P =
Page |1 »| Roceeds inpage (S0 selacted [0 T Filter.

P naw.. | [ Lot | of Doma | X Concal| (2 Halp |

PDQuest Query Tools allow accessto datain avariety of WorksBase record tables

WorksBase integration 8.
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(L] Matchset WB auto match [WB:1]

‘e Y Y s

= e -
rr‘!_]\r’na-w Entire Image
M Hide Overlays > ‘
B Transform...
Pg]Show Crosshairs
. o8 Show Symbols
w2 Show Offsets
Display S5Ps
= U, Pap-up Graph
. ' WS Margin Graph
P Create Analysis Set
¥ Select Analysis Set

RS Annotation Taal...
o/ Browse Annotations.
%] Find File Far...

Wiewr ldentifications in WorksBase...

Yiew Sarple Container in WorksBase

WH auto match (MWaster) [WE:20]
< i _
Direct connectivity from PDQuest Master Gel image to WorksBase

Right-click context sensitive menu allow WorksBase data viewing:
e View sample tracking information and status for excised spots through stepsin
mass spec identification process
e View final protein identification results

WorksBase integration 9.

| AR T
i'/iew Entire Image
Hide Overlays
" @R Transfarm. ..

85 Assign
FriInterchange Images
[ Image Infa...

LD [Bg] Show Crosshairs
Display SEPs
of Show Symbols

we Show Offsets
Shou Cluantity

[} (2 Matchset WB auto match [wB:1]
|

Sarmple info...
Gel info... 2
lRenamefReImk in WorksBase... ||

- W stockL v1 (Rav 2-D Imag) [l stockd v1 (Raw 2-D Imags) i stocks v1 (Raw 2-D Image)

Dlrect connectivity from PDQuest Member Gel |mages to WorksBase

Right-click context sensitive menu allow WorksBase data viewing:
e Sampleinfo
e Gedinfo
e Experiment and project relationships in WorksBase
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WorksBase integration 10.

{11l Open From WorksBase x|
- Gel Set Name |Ge\ Set Id Experiment Name(StepExpt)
WB auto match 1 two-fold
@Pm]ems o
i
Unfiltered
e I
%Experimems = pen image(s)
ﬂ = [EOpen Matchset(s)
in project
[ B e |
#| 2
in experiment x View...
i3 il . Cancel
ﬂ %%d Dirn Gels -
in expetiment @ Help
ﬂ EE Matchsets
in experiment
Page ﬂ 1 ﬂ Records inpage |1 selected |1 Y Fitter

Direct connectivity from WorksBase to PDQuest

Focus down to sample of interest in WorksBase and launch PDQuest to view associated
gel images or matchsets

The“ Standard Reference” imageisnow referred toasa“Master” image

The matchset composite image, formerly referred to in PDQuest as the “ Standard
Reference Image”, is now called the “Master” image. Thisimage contains arecord of all
spots that have been found to occur in any of the gelsin the matchset. Assuch, itis
useful to think of this composite as a convenient, single image view (or master library) of
all proteins that have been observed in the experiment.

Master 1.
[ Matulmel beta 358 excision (Modiied)
- w\h
- —
- - *»
- oy - D
) =
- . . L] & i
- ¥ ¥ -
" a i . . .”'
- - -
e e [ £t b b il beta 333 excision (MWaster, Modified)
- =
- - i st -

b
“Master” Image presents a convenient view of all proteinsin the experiment

2-D Scan images are now availablein M atchsets
Users can elect to view the original 2-D scan images within the matchsets. This optionis
available in addition to the filtered (background removed) or gaussian images.
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2-D Scan 1.
- o o Vi i~y U
- i WO iy - -+ "¥
= e - T
L ORAL GO .

Filtered image view 2-D Scan image (original gel image) view

» Preferences can be edited to alow any of these images to be presented as the default
view

» Theimagein asingle window can be interchanged at any time using the Menu
Command “Window>Interchange Image” (or F11)

*Theimagesin all windows can be interchanged simultaneously at any time using the

Menu Command “ Window>Interchange All Images” (or Shift-F11)

A proprietary SYPRO Ruby Speckle Filter has been added

SYPRO Ruby protein dye has become increasingly popular in proteomic research labs.
Unfortunately, the backgrounds of gels stained with SY PRO Ruby commonly exhibit
speckling artifacts (very small but intense flecks from precipitated dye). These speckles
can be easily misinterpreted as protein spots during the spot detection stage. In extreme
cases, the need to del ete these fal se spots manually can significantly increase the
requirement for spot editing.

To address thisissue, a proprietary SY PRO Ruby Speckle Filter has been developed to
selectively identify and remove these speckles from the background. Thisfilter worksin
conjunction with the PDQuest Median Filter, specifically targeting this algorithm to
remove only speckling artifacts from the background, without affecting the spot datain
other areas of the gel. When SY PRO Ruby speckles have been observed in the gel, the
user should manually apply the SYPRO Ruby Filter from the Filters tab in the Spot
Detection Wizard.

In order to compare performance of different filters, asingle 2-D Scan Image was copied
several times and subjected to different filtering treatments. The different images were
then subjected to spot detection under identical parameters and combined into asingle
matchset. The results are shown below;

Speckle 1.
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000301-T37_26 v1 x1 (Raw 2-D Image)

Raw 2-D Scan Image
e View isof theorigina 2-D image scan within a matchset
¢ Note small, intense SY PRO Ruby speckles throughout the view area
e Note square overlay on one SY PRO Ruby speckle indicating that this speckle was
both detected as a spot and found to have matching spots across the matchset gels

Speckltez

e 9 :
3, ,.._.“"""
® 'P

et *b

00001 TZ7_26 ¥ (Fleankd, Mo diind)

Image After Background Removal No Filtering
e Background and signal contrast is much improved
¢ SYPRO Ruby speckles are not affected
e Speckleisstill detected as a spot and considered a match (square overlay)

Speckle 3.

:

~Optional Contrals v -
-

| Streaks ||Elackgr0und Speckles

[X]Perform smoothing "'

- -

" Median 'Weighted Mean

Filter type .-
& Power Mean (" Contra Mean (" Adaptive "

Kermel Size @ 3x3 T hxb 7

JApply Sypro Ruby speckle filter Help
-

DO0GIL-TIT_26 FM Sltes vl Filersd, Meddied) |

Image After Background Removal and Filtering with Power Mean Filter
e Power Mean filter was automatically selected by the Spot Detection Wizard
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e Many SYPRO Ruby speckles have been removed & others are somewhat
diminished
e Speckleisstill detected as a spot and considered a match

Speckle 4.
-Optional Controls ®
| Streaks ||Elackgr0und Speckles ’ ”'
i#
[XPerform smoothing -
S
& Median 'Weighted Mean H
Filter type
("~ Power bean (" Contra Mean " Adaptive -
'b L
Kemel Size 3x3 ("BxE 77 .
L _
[ Apply Sypro Ruby speckle filter Help - . "
a

Image After Background Removal and Filtering with SY PRO Ruby Filter
e The user must manually select the median filter and apply the SY PRO Ruby filter
e Nearly al SYPRO Ruby speckles have been removed and the few remaining
speckles are diminished to a greater degree than with the Power Mean filter
e Speckleisno longer detected as a spot

Image Stack Tool has been enhanced

Two new functionalities have been added to the Image Stack Tool;

» Userscan flag spots of interest during review with thistool and create analysis sets
from these flagged spots for later review

» Flagged spots that are not already present in the Master image can be automatically
added to the Master image

Reviewing Local Regions Across Gels:

To review gels with the Image Stack Tool, the user should first choose the gels of interest
(either Filtered images or 2-D Scan images are recommended) from the gel image list and
initiate the Auto-playback mode of the Image Stack Tool. Localized areas of interest can
be inspected in detail using the Zoom Box tool. Different regions can be easily explored
using the Grab Tool to pan the view in any direction. Once the Grab Tool has been
enabled, the arrow keys may alternately be used to pan the view. Placing the cursor on
any spot in the tool’ simage display window will display a colored ellipse overlay on the
selected spot. As the displayed image advances to the next designated gel for review, the
spot that is the closest to the cursor position will then be selected (as represented with a
colored ellipse overlay). The user can also enable display of cross-hair overlays
indicating the locations of any spots that have been detected by the software. The Image
Stack Tool isuseful for both following representation of spots across the experiment as
well asidentifying spots where matching (or spot detection) problems may exist.
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Flagging Spots:
In the case where a spot of interest has been identified it is now possible to “flag” the

spotfor later review (for example, a spot with an interesting regulatory pattern, or one
where some manual editing of spot detection or matching may be required). To flag a
spot, ssmply hold down the control key and click on the spot of interest. The spot will be
marked. Any number of spots can be flagged simultaneously. Control-Shift Click can be
used to deselect a marked spot. During the selection operation, spots that are already
present in the Master image will be marked with a green “x”. Spots that are not present in
the Master image will be marked with ared “x”.

Saving and Reviewing Flagged Spots:

The user can save the set of flagged spots as a named Analysis Set. If any of these
flagged spots are not already present in the Master image, the user can elect to have these
spots automatically added to the Master during the save operation. Once saved, this
analysis set of flagged spots has the same characteristics as any other analysis set created
in PDQuest. It can be reviewed with the Analysis Set tools or Spot Review Tool,
included in reports or exported matchset data files, or converted into an Annotation
Category.

Image Stack Tool 1.

[la) Image stack Teol 'Matchset beta 70 2* — |0 il

Use ctrl-click to flag spots of mterest. (shift-ctrl-click to un-flag) — Selectgels to display
- a green cross means 'matched to master! beta 70 2 (Master) 4
- ared cross means 'must be added to master'

hzlfl w1 (Gaussian)
halfl vi {Filtered)
hzalfl w1 x3 (Raw 2-
hzlfz w1 (Gaussian)
halfz vi (Filtered)
hzalfz w1 x3 (Raw 2-
half3 v1 (Gaussian)
whalfi vl (Filtered)

| half3 w1l x3 (Raw 2-
stockl vl (Gaussiar

&

1| & stockl w1 (Filterec
J - . stockl vl x1 (Rawm :
L]

stocki w1l (Gaussiar

g - stocki vl (Filterec

@ stock: wl x3 [Ram ZLI

Al 2
Playback——————

Step ﬂﬂ X Auta

slow ——— [ fas

Image order
"Muve displayed image ﬂ ﬂ
rFlag spots ————————
[IShaw crosshairs SL Save flagged spot set

% Clearspotflags
Flagged spot count

« Done | D Help
Designating gels for review

» Shift-Click or Control-Click to select gel images
* Image in current view indicated with arrow
* Images can be re-ordered for logical viewing
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* Note user tip prompt for flagging commands
Image Stack Tool 2.
halty w1l [Gaussian)
wp half: vl [(Filtered)
halfz w1 x3 (Raw Z-
halfi w1 [Gaussian)
- half3 vl [(Filtered)
halfsi w1 =3 (Faw 2-
™ stockl vl [(Gaussiar
stockl vl (Filtereo

J
|
|
Close up of Currently Selected Spot Overlay

stockl w1

stocks vl

x1 ([(Raw :

[Gaussiar

Image Stack Tool 3.

nalfz vi (Gaussiam)
halzz vl [Filtered)
nalfz vi X3 (Baw Z-
nalfd vi (Gaussiam)
- halfd vl (Filtered)
s 2
fel . =
1 .
ol -
| -
4l
u
ek
sep 4| #| Do
ke £ | st
[ p——
M dipled image
Flag spats
(] Shrw crossheirs S fagged mot v
%, Clesespotfiags |
Flagged spot count |3
o Done | (71 Hetp |

» Green indicates spot already matched to Master

* Red indicates spot not yet in Master image
» Current selected set of flagged spots can be either cleared or saved

Image Stack Tool 3.
x|

& Add unmatched spots to the Master?

Count of flagged spots = 4,
Count of unmatched flagged spots =2

./Yesl)(_ Mo

User Prompt to Automatically Add Unmatched Spots to Master Image
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» Prompt displayed if user selects“ Save flagged spot set”
» Feedback on number of spots that would be added

Image Stack Tool 3.
x|

MName |Flagged Fet 1

Description |rEViEW for mismatch, missing spot

 Done | % Cancel
Naming Flagged Spot Set for Archiving as an Analysis Set

 Ability to add description of set
 FH agged Spot Set has same characteristics as any other Analysis Set;
can be selected and displayed as an Analysis Set
- can be viewed with the Spot Review Tool
- can be converted into an Annotation set
- can be combined with other Analysis Sets via Boolean Analysis set tools

Spot Review Tool now allows common editing commands while open
Tool now allows commands to add & delete spot, manually match & un-match spots, add
spotsto Master

Batch import of M S protein identification info

The batch import mode is compatible with Micromass M S identification results, both
directly from Micromass software and indirectly through WorksBase bioinformatics
software. With version 7.0.1, PDQuest can also import MASCOT (Matrix Sciences)
analyzed M S spectra from other mass spec instruments. The MASCOT import interface
issimilar to the Micromass import screens shown below.

MS Import 1.
I x|
Step 1 - Selec projact Step 3- Select sampla
Matchset A1 31-AUG-2000 il
A2 31=AU3=2000
A3 3 1= AUG=-2000
A4 31=-AUG=-2000

Instramant

Required project name [¢co01lannotate d_MA.pro
Masslyrx project |geoitmech_mA. PRO =

Seep 2 - Selectun
Sep 41-Seloct primary hit
tolimatch MA.mcp = L

[gene=FA3380] [proc=conser wed hypothetical protein] [commer
4 pepeides 21.71% coverage 16.6dkDa  7.68pH  acore 144

[gene=hasl] [proc=
4 peptides 10.33%

(ger -1 e
4 peptides 909

3 Applyall | (JReplace existing eniries without confmation (# q e ::L:; a) l:

Scom & Joint probability ™ MOWSE (gene=PAITIE] [pro o

“nypothetical protein] (o
pa

a psz;u-x

[gere=gleB] [proc=glu
4 pep ez

3 Apphy |

Fratsin Probe | f  Close | G1 Help
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Batch import option for M S protein identification runs

e User can elect to overwrite existing entries without confirmation prompt.
e Default isto prompt user to confirm or reject overwrite if a spot has already been
annotated with a protein identification

MS import 2.

(0 st bt G b arwsad st (Mo}

bage Dgan.
Elhghg et oot
_IMerk o annctmed wpots. Fome

[lMerk spots i cemgeny % Fomen |
Faa|  [E5eowspotamotasons Foman

Annotati)n Tool disblay of batch imported id.entificati.ons

Dcose| [ rHep -

During batch import, all annotation categories are created and entries are written

automatically.

» The highest confidence score identification is written as the Protein name annotation

» The entire probable hit list is written automatically as well, allowing subsequent
review of alternative hits

Import of Text Filesas Annotations

Text files can be used to import information as annotation entries to specific spots based
on their SSP #. In order for the PDQuest import operation to be successful, the targeted
SSP # must make up the first column in the import file.

Spreadsheet files must first be saved as text files in order to be compatible with the
PDQuest import operation. For example, in MS Excel choose the “File> Save as...”
command to save thefile as atext file (for example, file_name.txt).

Annotation import 1.

SSP enzyme functionality  x-ray structure  metabolic path
101 YES + deglycosylation
105 NO Krebs
1202 YES + ATP
1301 NO Clotting
402 NA +
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Example of spreadsheet file (* .xIs format) with SSP import identifiers before saving as a
text file

In the above example, there is a header row, which defines the SSP # column, as well as
three attribute columns. Each column has a number of annotation entriesin it.
e Blank fields will betolerated in the import operation

Annotation import 2.

SSP enzyme functionality X-ray structure metabolic path
1701 YES + deglycosylation
1608 NO Krebs

3201 YES + ATP

2804 NO clotting

4909 NA +

Example of text file (*.txt format) with SSP import identifiers after conversion from
spreadsheet file

Annotation import 3.

Spats  Match

Analysis Identification  Reports  Window  Help

Spot Review Toal, ..
Image Stack Toal...

Scatter Plok Toal..,
#A-B Comparison
L

Replicate Graups
Quantitstion Mode...  Cr+Fa
Normalize. ..

Analysis Sets

Annatation Tool, .
Annatation Select Tool

Mare Annat, Tools Brawse Annatations. ..
Find Filz For...
. Mrpl Standards 3
Create Annotation from Set
Spot Mumbers o
AT VL SRR LA T Prink Annatations »

Trapart Annatations. .
Transfer Annotations. ..
- - -

Import opéraEi on menu
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lm Import Annotations - 71 set 1 il
File to import ‘lmpnr{ tat =
Header line ‘SSPDEI’]ZYI’HE functionalityOx-ray structureOmetabolic pathOO
First data line ‘17D1DYESEI+EIdeg\ycnsylatinnElEl
[X]Firstline is header [X] Caonfirm overwrites
Calumn Delimiter a Select catego
" Comma & Tab ‘
idenmeth
rPielate Colurn to Category Select Category metab path
Column 1 (S5P) [enz funct I‘mpmm mrpi
SSPOenzyme functionalityOx-ray etructureODmetabolic pathOC watform
Coluwn 2 (enzywe functionalit
= MM | [17010VESO+OdeglycosylationdD notes
Column 3 {x-ray strusture) [Jshow description header [XConfirm ovenwrites physprop
Coluen 4 (metabolic path) plascode
e plasloc
= Tab postrmod
0 Categon Select Category protiunc
protname
(55P) ’7’7 i1
purific
£ t lit
(enzyme functionali Add. | i cefer
{x-ray structure) [JShow description related
imetabolic path)
rflploc
subeeloc
SYnonyvm
1 »
_I_I _I tissdist
- - ¥-ray struct
<  Import |X Cancel |Load Setings ‘Sa\:e Settings | & Help wlatreq

Annotation Import dialogue

Multiple columns files can be imported and the annotations flexibly routed to the
appropriate annotation category.

The user selects some or al of the available columns to be converted into annotations
The user routes the import file column data by selecting the column in the “Relate
Column to Category” field, and assigning the entriesin that column to a specific
Annotation Category in the “ Select Category” field.

Annotation categories can be chosen from pre-existing categories, or new ones can be
created with the “Add...” button\

Importation routing settings can be saved and later recalled (“ Save Settings’ / “Load
Settings’)

The import tool accommodates both Comma and Tab delimited text files

The import tool accommodates files with or without column headers

User option to prompt for confirmation before overwrite of existing entries

File System and Archiving Changes

e Standard browser open/save dialogues are now supported (the previous PDQuest
custom open dialogue is still available as a user-definable option under “Edit>
Preferences’).

e Member images can now be members of multiple Matchsets and annotations can
be shared between matchsets or be private to a single matchset

e Matchset members can be found automatically if moved on the hard disk outside
of PDQuest
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Reporting

TIFF images can be exported with displayed overlays and annotations as they appear on-
screenin color.

New report features have been added for selected reports, including Page Setup and Print
Preview.

TIFF export1.
|

rExport Mode
Analysis

™ export raw data

Fublishing
™ export view excluding overlays

" export view including overlays

rFesolution (dpi)
@i2dpi " Sameasscan (144.3)

{150 dpi
™ Specify [72.0
£ 300 dpi
r Transform Bit Depth Zoom
™ Linear £ 8 bit ™ Entire image
" Currentwiew || <™ 16 bit " Current view
" 24 hit RGE
rSize
Pixels % [231 v[a13 Image [70.61 Ko

Export| X_Cancel| (A Help ‘

Exporting image view with overlays

Retired Features

e Windows95isno longer supported
e Multiple exposuresof samegel are no longer supported
e Matchsetsfile name conventions have changed
0 PDQuest Matchsets now consist of a <name>.ms file and a corresponding
<name> Data directory
0 Previously aMatchSet was adirectory and could not be opened with the
standard system open dialog
e PDQuest 7.0/ 7.0.2 will nolonger open gel spot files produced by version 3.85
or older (version 3.85 wasreleased in 1988)
0 Thesefilesmust befirst opened and saved with PDQuest 6.2

SYPRO Ruby is a trademark of Molecular Probes
Micromass is a trademark of Micromass
Mascot is a trademark of Matrix Science Limited
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